1. About Stellar Toolkit for MS SQL

Stellar Toolkit for MS SQL is a collection of following software:

- Stellar Backup Extractor for MS SQL
- Stellar Repair for MS SQL
- Stellar Password Recovery for MS SQL
2.1. Installation Procedure

Before beginning the installation procedure, make sure that the computer meets the minimum system requirements.

**Minimum System Requirements:**

- **Processor:** Intel Pentium Class
- **Operating system:** Windows Server 2012 / 2008 / 2003 and Windows 10 / 8.1 / 8 / 7
- **Hard Disk:** At least 250 MB of free disk space
- **RAM:** 2 GB minimum (4 GB recommended)
- **MS SQL Server:** MS SQL Server 2019, MS SQL Server 2017, MS SQL Server 2016, MS SQL Server 2014, MS SQL Server 2012, MS SQL Server 2008 R2, 2008, 2008 (64 bit), 2008 Express, MS SQL Server 2005, 2005 (64 bit), 2005 Express, MS SQL Server 2000, 2000 (64 bit), 7.0 and mixed formats.

To install the software, follow the steps:

1. Double-click **StellarToolkitforMSSQL.exe. Setup** dialog box is displayed.
2. Click **Next** to continue. **License Agreement** dialog box is displayed.
3. Select **I accept the Agreement** option. Click **Next**.
4. Specify the location where the installation files are to be stored. Click **Next**.
5. Select the folder where the files are to be stored. A default folder is suggested in the box. Click **Browse** to select a different location. Click **Next**.
6. In the **Select Additional Tasks** dialog box, select check boxes as per your choice. Click **Next**.
7. Review your selections. Click **Back** if you want to make any change. Click **Install** to start installation. The **Installing** window shows the installation process.
8. After completion of the process, **Completing the Stellar Toolkit for MS SQL Setup Wizard** window opens. Click **Finish**.

**Note:** Clear **Launch Stellar Toolkit for MS SQL** check box to prevent the software from launching automatically.
2.2. Launching the Software

To launch Stellar Toolkit for MS SQL in Windows 10:

- Click Start icon -> All apps -> Stellar Toolkit for MS SQL -> Stellar Toolkit for MS SQL Or,
- Double click Stellar Toolkit for MS SQL icon on the desktop. Or,
- Click Stellar Toolkit for MS SQL tile on the home screen.

To launch Stellar Toolkit for MS SQL in Windows 8.1 / 8:

- Click Stellar Toolkit for MS SQL tile on the home screen. Or,
- Double click Stellar Toolkit for MS SQL icon on the desktop.

To start the application, do one of the following in Windows 7:

- Click Start -> All Programs -> Stellar Toolkit for MS SQL -> Stellar Toolkit for MS SQL. Or,
- Double click the Stellar Toolkit for MS SQL icon on the desktop. Or,
- Click Stellar Toolkit for MS SQL icon in Quick launch.
2.3. User Interface

Stellar Toolkit for MS SQL software has a very easy to use Graphical User Interface. The user interface contains features required for complete recovery of corrupt MS SQL Server (MDF) files, recovery of corrupt MS SQL Backup (.bak) files, recovery of the password of MS SQL (master.mdf) file of the database.

After launching the program, you will see the main user interface as shown below:
Buttons

Following buttons are present on the main user interface of Stellar Toolkit for MS SQL software:

- **About**
  
  Click this button to read more information about the software.

- **Activate**
  
  Click this button to activate the software after purchasing.

- **Buy**
  
  Click this button to buy the software.

- **Help**
  
  Click this button to open the help manual for Stellar Toolkit for MS SQL.
2.4. Ordering the Software

Click http://www.stellarinfo.com/sql-database-toolkit.php to know more about Stellar Toolkit for MS SQL.

To purchase the software online, please visit http://www.stellarinfo.com/database-recovery/sql-toolkit/buy-now.php

Alternatively, click on the main user interface to buy the software online.

Select either of the methods given above to purchase the software.

Once the order is confirmed, a serial number will be sent to you through e-mail, which would be required to activate the software.
2.5. Activating the Software

The demo version is just for evaluation purposes and must be eventually registered to use the full functionality of the software. The software can be registered using the Activation Key that you receive via email after purchasing the software.

To activate the software:

1. Run the demo version of Stellar Toolkit for MS SQL software.

2. Click on the main user interface. The Activation window is displayed as shown below:

3. If you don't have the activation key, click the Get it now button in the window to go online and purchase the product.

4. Once the order is confirmed, an Activation Key will be sent to the email provided.

5. Type the Activation Key (received through email after purchasing the product) and click Activate button (Please ensure that you have an active Internet connection).

6. The software will automatically communicate with the license server to verify the entered key. If the key you entered is valid, the software will be registered successfully.

7. The 'Activation Completed Successfully' message is displayed after the process is completed successfully. Click OK.
2.6. Stellar Support

Our Technical Support professionals will give solutions for all your queries related to Stellar products.

You can either call us or go online to our support section at http://www.stellarinfo.com/support/

For price details and to place the order, click http://www.stellarinfo.com/database-recovery/sql-toolkit/buy-now.php

Chat Live with an Online technician at http://www.stellarinfo.com/

Search in our extensive Knowledge Base at http://www.stellarinfo.com/support_kb

Submit enquiry at http://www.stellarinfo.com/support/enquiry.php

Send e-mail to Stellar Support at support@stellarinfo.com
Stellar Backup Extractor for MS SQL

User Guide for version 10.0
1. General Information

1.1. About Stellar Backup Extractor for MS SQL

1.2. About the Guide

1.3. Stellar Support
1.1. About Stellar Backup Extractor for MS SQL

Stellar Backup Extractor for MS SQL software is an easy to use application designed to recover MS SQL database from corrupt MS SQL database backup (.BAK) files and save them in various output formats.

Microsoft SQL Server database backup files (.BAK) can be damaged or corrupted due to a number of reasons such as virus attack, unexpected system shutdown, media read error, and so on. Using strong algorithm, Stellar Backup Extractor for MS SQL does a complete repair of the corrupt backup file and efficiently repairs every bit of MS SQL database information without deleting or modifying original data. Even heavily damaged file can be optimally repaired with this software.

After repairing, Stellar Backup Extractor for MS SQL provides preview of extracted database backup file in a tree structure. User can view the components (tables, table data, views, constraints, indexes, keys, etc.) of the selected database backup file and can save the desired components.

The software also shows details of ongoing process in a Log Report pane. These details can be saved as a text file.

Key Features:

- Efficiently repairs MS SQL Server database backup (.BAK) file without making changes to original file.
- Shows preview of database before saving.
- Find option to search items of database while previewing.
- Option to save repaired database to New or Live database.
- Option to save repaired database as MDF, CSV, HTML and XLS.
- Option to save the scan information to resume the repair process at a later stage.
- Option to view and save log of scan, preview and saving process.
- Supports Advanced Scan Option (for highly corrupted files).
- Supports both Windows and SQL Server Authentication while saving the repaired file as MDF.
- Supports total row count detail in each table for all versions.
- Supports Sorted tables in tree view and generates sorted log report.
- Repairs and extracts Tables, Triggers, Views, Collations, Stored Procedure, Synonyms, Functions, Defaults and Default constraints, Primary Keys, Foreign Keys, Unique Keys, Identity, Indexes (Clustered, Non - Clustered indexes), Check constraints, User Defined Data Types, Null / Not null, Predefined defaults, default values, and Rules.

1.2. About the Guide

This user guide contains sequential steps to assist you through various Stellar Backup Extractor for MS SQL functions.

Each function is explained in details, in the corresponding sections. The guide covers following major topics:

1. General Information
2. Getting Started
3. Working with the Software
4. Frequently Asked Questions (FAQ)

This guide has the following features for easy navigation and understanding:

- There are Notes and Tips in some topics of this guide for better understanding and ease of work. These Notes and Tips are given in italics style.
1.3. Stellar Support

Our Technical Support professionals will give solutions for all your queries related to Stellar products.

You can either call us or go online to our support section at http://www.stellarinfo.com/support/

For price details and to place the order, click https://www.stellarinfo.com/database-recovery/sql-backup/buy-now.php

Chat Live with an Online technician at http://www.stellarinfo.com/

Search in our extensive Knowledge Base at http://www.stellarinfo.com/support/kb

Submit enquiry at http://www.stellarinfo.com/support/enquiry.php

Send e-mail to Stellar Support at support@stellarinfo.com
2.1. Installation Procedure

Before beginning the installation procedure, make sure that the computer meets the minimum system requirements.

**Minimum System Requirements:**

- **Processor:** Intel Pentium Class
- **Operating system:** Windows Server 2012 / 2008 / 2003 and Windows 10 / 8.1 / 8 / 7
- **Hard Disk:** At least 250 MB of free disk space
- **RAM:** 2 GB minimum (4 GB recommended)
- **MS SQL Server:** MS SQL Server 2019, MS SQL Server 2017, MS SQL Server 2016, MS SQL Server 2014, MS SQL Server 2012, MS SQL Server 2008 R2, 2008, 2008 (64 bit), 2008 Express, MS SQL Server 2005, 2005 (64 bit), 2005 Express, MS SQL Server 2000, 2000 (64 bit), 7.0 and mixed formats.

To install the software:

1. Double-click *StellarToolkitforMSSQL.exe*. **Setup** dialog box is displayed.
2. Click **Next** to continue. **License Agreement** dialog box is displayed.
3. Select **I accept the Agreement** option. Click **Next**.
4. Specify the location where the installation files are to be stored. Click **Next**.
5. Select the folder where the files are to be stored. A default folder is suggested in the box. Click **Browse** to select a different location. Click **Next**.
6. In the **Select Additional Tasks** dialog box, select check boxes as per your choice. Click **Next**.
7. Review your selections. Click **Back** if you want to make any change. Click **Install** to start installation. The **Installing** window shows the installation process.
8. After completion of the process, **Completing the Stellar Toolkit for MS SQL Setup Wizard** window opens. Click **Finish**.

**Note:** Clear **Launch Stellar Toolkit for MS SQL** check box before clicking **Finish** to prevent the software from launching.
2.2. Launching the Software

To launch Stellar Backup Extractor for MS SQL in Windows 10:

- Click **Start** icon -> **All apps** -> **Stellar Toolkit for MS SQL** -> **Stellar Toolkit for MS SQL** -> **Extract from MS SQL Backup** Or,
- Double click **Stellar Toolkit for MS SQL** icon on the desktop -> **Extract from MS SQL Backup**. Or,
- Click **Stellar Toolkit for MS SQL** tile on the home screen -> **Extract from MS SQL Backup**.

To launch Stellar Backup Extractor for MS SQL in Windows 8.1 / 8:

- Click **Stellar Toolkit for MS SQL** tile on the home screen -> **Extract from MS SQL Backup**. Or,
- Double click **Stellar Toolkit for MS SQL** icon on the desktop -> **Extract from MS SQL Backup**.

To start the application, do one of the following in Windows 7

- Click **Start** -> **All Programs** -> **Stellar Toolkit for MS SQL** -> **Stellar Toolkit for MS SQL** -> **Extract from MS SQL Backup**. Or,
- Double click the **Stellar Toolkit for MS SQL** icon on the desktop -> **Extract from MS SQL Backup**. Or,
- Click **Stellar Toolkit for MS SQL** icon in Quick launch -> **Extract from MS SQL Backup**.
2.3. User Interface

**Stellar Backup Extractor for MS SQL** software has a very easy to use Graphical User Interface. The user interface contains features required for complete recovery of corrupt MS SQL database backup (.BAK) files.

After launching the program, you will see the main user interface as shown below:

The user interface contains ribbons and buttons that lets you access various features of the software with ease.
2.3.1. Ribbons

**File Ribbon**

**Select File**

Use this option to select the corrupt .BAK file for repairing.

**Save**

Use this option to save the repaired SQL database backup file.

**Stop**

Use this option to stop an ongoing process.

---

**Status Bar and Log Window**

Check/Uncheck these boxes to view or hide the Status Bar and Log Window.

**Find**

Use this option to find particular item in tree.

To narrow down the search result, you can select **Match Case** or **Match Whole Word** check box.
Tools Ribbon

Save Log

Use this option to save log information in a text file.

Clear Log

Use this option to clear the log information from Log Report pane.

Update

Use this option to check for both, latest minor and major versions available online.

Help Ribbon

Help Topics

Use this option to open help manual for the software.

Support

Use this option to view the support page.

Knowledgebase

Use this option to visit Knowledgebase articles of stellarinfo.com

About

Use this option to read information about the software.
Buy Now Ribbon

Buy Online

Use this option to buy the software online.

Activation

Use this option to activate the software.
2.3.2. Buttons

- **Select File**: Click this button to select the corrupt .BAK file for repairing.
- **Save**: Click this button to save the repaired SQL database backup file.
- **Stop**: Click this button to stop an ongoing process.
- **Save Log**: Click this button to save log information in a text file.
- **Clear Log**: Click this button to clear the log report.
- **Update**: Click this button to update your software. Use this option to check for both, major and minor versions of the software.
- **Help Topics**: Click this button to open the help manual for Stellar Backup Extractor for MS SQL.
- **Support**: Click this button to view support page of stellarinfo.com.
- **Knowledgebase**: Click this button to visit the Knowledge Base articles of stellarinfo.com.
Click this button to read more information about the software.

Click this button to purchase the software online.

Click this button to activate the software after purchasing.
2.4. Ordering the Software

To know more about Stellar Toolkit for MS SQL, [click here](#).


Alternatively, click on Buy Online icon in Buy Now ribbon to purchase the software online.

Select either of the methods given above to purchase the software.

Once the order is confirmed, you receive an Activation Key through e-mail. You require this key to activate the software.
2.5. Activating the Software

The demo version is just for evaluation purpose and must be eventually activated to use the full functionality of the software.

The software can be activated using the Activation Key which you will receive via email after purchasing the software.

To activate the software:

1. Launch the demo version of the software.
2. On Buy Now ribbon, click Activation button. Activation window is displayed as shown below:

   ![Activation Window](image)

3. If you don't have the Activation Key, click Get it now button in the window to go online and purchase the product.
4. Once the order is confirmed, an Activation Key gets sent to the email provided.
5. Type the Activation Key (received through email after purchasing the product) and click Activate button (Please ensure that you have an active Internet connection).

   ![Activation Window](image)

6. The software would automatically communicate with the license server to verify the entered key. If the key you entered is valid, the software will be activated successfully.
7. ‘Activation Completed Successfully’ message is displayed after the process gets completed successfully. Click OK.
2.6. Updating the Software

There are periodical software updates for Stellar Backup Extractor for MS SQL. Using the update option, you can check for both the latest minor and major version available online. You can easily download the minor and major version through the update wizard. While updating the software, it’s recommended to close all the running programs.

To start Stellar Backup Extractor for MS SQL Update Wizard:

1. Launch the software.
2. Select Update from Tools ribbon.
3. Update window pops up.
4. The wizard will start searching for the latest updates and if it finds any new version, a window will pop up indicating the availability an update.
5. Click Next and the software will start downloading update files from the server. When the process is complete, the software will updated to the latest version.

Live Update may not happen due to following reasons:

- Internet connection failure.
- Unable to download configuration files.
- Unable to locate updated files or version.
- Unable to locate executable file.
3. Working with the Software

3.1. Select MS SQL Database Backup (.BAK) File
3.2. Select the Scan Mode
3.3. Select Backup Set
3.4. Preview and Save Repaired Files
3.5. Save Scan Information
3.6. Find Specific Item In Tree
3.7. Save Log Report
3.1. Select MS SQL Database Backup (.BAK) File

To Browse a MS SQL database backup (.BAK) file,

1. Run Stellar Backup Extractor for MS SQL Application.

2. Select File dialog box is displayed.

3. In Select File dialog box, click Browse.

4. In the Open dialog box, browse and select the corrupt MS SQL Backup (.BAK) file and then click Open.

5. Click Scan.

Note: You can also select the (.BAK) file by choosing Select File icon from File Ribbon.
To Search MS SQL Database Backup (.BAK) file,

1. Run **Stellar Backup Extractor for MS SQL** Application.

2. **Select File** dialog box is displayed.

3. In **Select File** dialog box, Click on **Search**.

4. **Browse for Folder** dialog box opens. Select the drive or folder to search for the MS SQL Backup files. Click **OK**. Search process starts.

5. After the search is finished, a list of .BAK files found in the selected drive are shown in a list. File attributes like size, modified date, created date, last accessed date is also shown with the file.

6. Select file you wish to recover from this list and click **Scan** button to start the process.

**Note:** Click **Clear list** to clear the searched results.

**Note:** You can also select the (.BAK) file by choosing **Select File** icon from **File Ribbon**.
3.2. Select the Scan Mode

After selection of MS SQL Backup file that you want to repair, click Scan. Select Scan Mode dialog box opens. Stellar Backup Extractor for MS SQL has two modes for scanning:

- **Standard Scan (Recommended)** - Select Standard Scan to scan and repair corrupt .BAK files that are not highly corrupted.
- **Advanced Scan** - Select Advanced Scan to scan the extremely corrupted .BAK files for better and effective results.
3.3. Select Backup Set

To proceed the scanning process you have to select a Backup to recover. These are the following steps to select Backup Set:

1. Select MS SQL Backup file in Stellar Backup Extractor for MS SQL.
2. Select the Scan Mode i.e. Standard or Advance scan.
3. Click OK button to start scanning process. Select Backup Set dialog is displayed. All the backups taken in different Backup Modes and all the backups (incase the backup is stored in different files) are shown.

4. Click and select a Backup Set.
5. If selected Backup is located in multiple files a dialog showing this is displayed. Click Add to select more locations that contain other supplementary files.
6. Click Next to start scanning.

**Note:** Resume Repair dialog box is displayed if a previous repair result is available for the selected backup file. Select the desired option.

7. After completion of the scanning process. Repair Complete dialog box is displayed. Your MS SQL backup file has been recovered successfully. Click OK.

**Note:** Click Save button from File Ribbon to save the repaired SQL database backup file.
3.4. Preview and Save Repaired Files

After you complete the repairing process successfully, Stellar Backup Extractor for MS SQL shows preview of corrupted database backup files. The left pane displays list of items (Tables, Views, Synonyms, Defaults, Data Types and more) in a tree like structure, upper right pane displays the contents of the item selected in the tree view and bottom pane shows message log. A sample screen is displayed below:

By default, all the checkboxes of the tree view are selected. You can click on the item in the tree view to preview its content.

Note: The software performs a counting of records present in the database after repairing process is completed. The time taken in counting depends on the number of records present in the database.

To save the repaired file to MS SQL database:

- After the repairing process gets completed, click Save option from File ribbon.
- Specify whether you want to save the repaired database in MDF, CSV, HTML or XLS format by selecting the appropriate radio button.

Saving repaired database as MDF
Saving repaired database as CSV, HTML or XLS
To save the repaired file as MDF, you can either save your database as a **New database** or you can insert the data to an existing **Live database**.

- To save the repaired database as a completely **New database**, follow the steps mentioned below:
  - Select **New Database** radio button.
  - Enter **Server / Instance Name**.
  - Choose the **Authentication** method from the drop down list for logging in to the server. If the authentication method selected is **Windows Authentication**, you need not enter any user name and password.
  - Enter the server user name and password, if the selected authentication method is **SQL Server Authentication**.
  - Select a destination for saving the repaired .BAK file.
Click **Save** button to save the repaired MS SQL Database Backup file. A message is displayed after the process is completed successfully.

![Save Complete](image)

- To save the repaired database in an existing **Live database**, follow the steps mentioned below:
  - Select **Live Database** radio button.
  - Enter **Server / Instance Name**.
  - Choose the **Authentication** method from the drop down list for logging in to the server. If the authentication method selected is **Windows Authentication**, you need not enter any user name and password.
  - Enter the server user name and password, if the selected authentication method is **SQL Server Authentication**.

![Save Database](image)
From the Existing Database drop down button select the database into which you want to save the repaired file.

Click Save button to save the repaired MS SQL Database Backup file. A message is displayed after the process is completed successfully.

To save the repaired file to CSV, HTML or XLS format:

- After the repairing process gets completed, go to File ribbon and select Save option.
- Save Database dialog box will open. Select the required format.
• Click **Browse** to go to the folder where you want to save the repaired file and click **Save** button.

• The file will be saved in the desired format.

**Note:** *Make sure MS SQL Server is running during repair process.*
3.5. Save Scan Information

Stellar Backup Extractor for MS SQL saves a scan information of the MS SQL Database Backup File at the time of repairing. This saved scan information can be used later to repair corrupt backup file in case you wish to repair the database backup file again.

Using a scan information saves time, since scanning of each database backup file does not take place. All files and folders shown after scan process can be viewed as we load the saved scan information created for that particular scan. You can resume recovery by selecting the saved scan information without scanning the backup file again.

To repair backup file using scan information:

1. You will be prompted to use the saved scan information for selected backup file.
2. Click Yes if you want to repair using the existing saved scan information.
3. Click No if you want to repair using selected backup file itself.
3.6. Find Specific Item In Tree

Stellar Backup Extractor for MS SQL gives option to find particular items in tree view. After completion of repairing process, a search bar along with the preview window appears as shown below:

To find a particular item, enter its name in Find text box and click Find button. If that item is present in the database, it is highlighted in tree. Use back and forward button to traverse in the tree.

To narrow down the search result, you can select Match Case or Match Whole Word check box.
3.7. Save Log Report

With Stellar Backup Extractor for MS SQL, you can save the Log Report to analyze the repairing process at a later stage. You can view log of the process at the bottom of the user interface. If this pane is not visible, you can enable it by selecting the Log Window checkbox in View section of File Ribbon.

To save log report:

1. From Tools ribbon, select Save Log.
2. In Save As dialog box, select the location where you want to save the log report. Click Save.

To clear log report:

1. From Tools ribbon, select Clear Log.
4. Frequently Asked Questions (FAQ)

1. What does the demo version of the software do?
   Demo version of the software shows only preview of the database. To save recovered database, you need to purchase and activate the software.

2. Does the recovery software make changes to original database file?
   The software asks for location to save the database. If you choose the default location, database will be replaced with the recovered one.

3. How to know whether the software will be able to recover my database or not?
   To know whether the software will be able to recover your MS SQL Backup database or not, please try demo version of the software. Scan your file using **Stellar Backup Extractor for MS SQL** and preview results for your satisfaction.

4. Can Stellar Backup Extractor for MS SQL recover my deleted MS SQL Backup database?
   No.

5. How much time Stellar Backup Extractor for MS SQL will take to scan and recover database?
   The time taken in scanning and recovering database is totally dependent upon the size of database file.

6. Is MS SQL Server needed to be installed on the system for previewing database?
   No.

7. Is MS SQL Server needed to be installed on the system for recovering database?
   Yes, MS SQL Server must be installed and its services must be in running state while recovering.

8. Can we recover tables in a database file selectively?
   Yes, you can recover single or multiple tables. Simply select desired tables in tree view and start recovery process.

9. I want to locate an item in the database file. Is there any way I can do this using the software?
Yes, after scanning .BAK file, the software gives you option to find items in tree view. Use *Find* option to locate desired item in a database.

10. **How can Stellar Backup Extractor for MS SQL help me search for the location of MDF file in the computer?**

You can search for MDF file in the computer using *Search* option of the software. For more details, please refer Select MS SQL backup file topic of the help manual.

11. **How can we view process log?**

You can view log of the process at the bottom of the user interface. If this pane is not visible, you can enable it by selecting the *Log Window* checkbox in *View* section of *File Menu*.

12. **Can we save process log?**

Yes, *Stellar Backup Extractor for MS SQL* gives you option to save log report of the process.

To save log report:

- From *Tools Menu*, select *Save Log*.
- In *Save As* dialog box, select the location where you want to save the log report. Click *Save*. 
Overview

**Stellar Repair for MS SQL** software is an easy to use application designed to repair corrupt or damaged Microsoft SQL Server database (MDF) files in a safe and non-destructive manner. It uses powerful algorithms to perform thorough scan of MDF file so as to recover as much data as possible. The software never deletes or modifies original data and even heavily damaged files can be optimally repaired and restored.

Microsoft SQL server system is a full-fledged relational database management system (RDBMS) that offers an exclusive variety of a number of administrative tools for database development, maintenance, and administration. Microsoft SQL Server database files (MDF) can get damaged or corrupted due to a number of reasons such as virus attack, unexpected system shutdown, media read error, and so on.

**Key Features**

- Saves the Scan Information.
- Option to save repaired database to SQL Server Authentication.
- Searches MDF files in the computer.
- Displays preview of recoverable database objects.
- Allows finding of object name in tree view.
- Supports Sequence Objects in MS SQL Server.
- Supports MS SQL Server ROW Compressed data.
- Supports MS SQL Server PAGE Compressed data.
- Supports Standard Compression Scheme for Unicode (SCSU) in SQL Server.
- Recovers Column Row GUID COL Property.
- Recovers Sp_addextended Property.
- Saves non-recovered queries, views, stored procedures, etc. in a text file.
- Support for automatic recreation of a new database having all the recovered database items.
- Support for large SQL Server MDF files for all versions.
- Support for XML data types.
- Support for XML indexes.
- Support for SQL Server filestream data types.
- Support for SQL Server sparse columns.
- Support for SQL Server columns set property.
- Support for separate log report after scanning database.
- Support for Sorted tables in tree view and generates sorted log report.
- Support for fast scanning algorithms.
- Support for total row count detail in each table for all versions.
- Recovery of Tables, Triggers, and Views.
- Recovery of Collations.
- Recovery of Stored Procedure, Synonyms, and Functions.
- Recovers of Defaults and Default constraints.
- Recovery of Primary Keys, Foreign Keys, Unique Keys, and Identity.
- Recovery of Indexes (Clustered, Non-Clustered indexes).
- Recovery of Check constraints, User Defined Data Types, and Null / Not null.
- Recovery of Predefined defaults, default values, and Rules.
- Option to recover deleted records.
- Option to save repaired database to New or Live database.
- Option to save repaired database as MDF, CSV, HTML and XLS.
Installation Procedure

Before beginning the installation procedure, make sure that the computer meets the minimum system requirements.

Minimum System Requirements:

**Operating system:** Windows Server 2012 / 2008 / 2003 and Windows 10 / 8.1 / 8 / 7

**Hard Disk:** At least 250 MB of free disk space

**RAM:** 2 GB minimum (4 GB recommended)

**MS SQL Server:** MS SQL Server 2017, MS SQL Server 2016, MS SQL Server 2014, MS SQL Server 2012, MS SQL Server 2008 R2, 2008, 2008 (64 bit), 2008 Express, MS SQL Server 2005, 2005 (64 bit), 2005 Express, MS SQL Server 2000, 2000 (64 bit), 7.0 and mixed formats.

To install the software, follow the steps:

1. Double-click Stellar Toolkit for MSSQL.exe. Setup dialog box is displayed.
2. Click Next to continue. License Agreement dialog box is displayed.
3. Select I accept the Agreement option. Click Next.
4. Specify the location where the installation files are to be stored. Click Next.
5. Select the folder where the files are to be stored. A default folder is suggested in the box. Click Browse to select a different location. Click Next.
6. In the Select Additional Tasks dialog box, select check boxes as per your choice. Click Next.
7. Review your selections. Click Back if you want to make any change. Click Install to start installation. The Installing window shows the installation process.
8. After completion of the process, Completing the Stellar Toolkit for MS SQL Setup Wizard window opens. Click Finish.

**Note:** Clear Launch Stellar Toolkit for MS SQL check box to prevent the software from launching automatically.
Launching the Software

To launch Stellar Repair for MS SQL in Windows 10:

- Click Start icon -> All apps -> Stellar Toolkit for MS SQL -> Stellar Toolkit for MS SQL -> Repair MS SQL Database
  Or,
- Double click Stellar Toolkit for MS SQL icon on the desktop -> Repair MS SQL Database
  Or,
- Click Stellar Toolkit for MS SQL tile on the home screen -> Repair MS SQL Database.

To launch Stellar Repair for MS SQL in Windows 8:

- Click Stellar Toolkit for MS SQL tile on the home screen -> Repair MS SQL Database
  Or,
- Double click Stellar Toolkit for MS SQL icon on the desktop -> Repair MS SQL Database

To start the application, do one of the following in Windows 7:

- Click Start -> All Programs -> Stellar Toolkit for MS SQL -> Stellar Toolkit for MS SQL -> Repair MS SQL Database
  Or,
- Double click the Stellar Toolkit for MS SQL icon on the desktop -> Repair MS SQL Database
  Or,
- Click Stellar Toolkit for MS SQL icon in Quick launch -> Repair MS SQL Database.
**User Interface**

*Stellar Repair for MS SQL* software has a very easy to use Graphical User Interface. The user interface contains features required for complete recovery of corrupt MS SQL Server (MDF) files.

After launching the program, you will see the main user interface as shown below:

The user interface contains ribbons and buttons that lets you access various features of the software with ease.

When you start *Stellar Repair for MS SQL*, the **Select database** dialog box opens as shown below:

To select a database, click on **Browse** button. Select the MDF file that needs to be repaired and then click **Repair** to start the repairing process.
Stellar Repair for MS SQL also allows you to search for MDF file that needs to be repaired, in case you don't know it's location. In Search section, select the drive in which you want to search for the MDF file and then Click OK to start searching for files.

*Note: Select database* dialog box can also be opened by selecting *Select database* in the File ribbon.
Ribbons

File Ribbon

Select Database

Use this option to select the corrupt SQL database for repairing.

Save

Use this option to save the repaired SQL database.

Stop

Use this option to stop the repairing process.

View

Use this option to view or hide the Status Bar and Log Window.

Deleted Records

Select this check box to show or hide deleted records in the tree view (if found) during the repairing process.

Search String

Use this option to search a string in the database file.

Tools Ribbon
Save Log

Use this option to save the log report.

Clear Log

Use this option to clear the log report.

Update

Use this option to update the software.

Help Ribbon

Help Topics

Software is accompanied by a descriptive help document. Use this option to view the help manual for the software.

Support

In case you don't find any related content in the help document or on the knowledgebase page that resolves your query, use this option view the support page of stellarinfo.com and contact the Stellar customer support.

Knowledge Base

Frequently asked questions and other common queries are available as knowledgebase for your reference and to help you use the software to get the best outcome. Use this option to visit Knowledge Base articles of stellarinfo.com

About

Use this option to read more information about the software.
Buy Now Ribbon

Buy Online

Use this option to buy Stellar Toolkit for MS SQL.

Activation

You can repair corrupt or damaged Microsoft SQL Server database (MDF) files to recover as much data as possible using the trial version of the software. To save the recovered data, you need to purchase and activate it. Use this option to activate the software after the successful purchase.
Buttons

Click this button to open Select SQL database dialog box.

Click this button to save the repaired SQL database.

Click this button to stop the repairing process.

Click this button to save the log report, which contains the details of the repairing process.

Click this button to clear the log report.

Click this button to activate the software after purchasing.

Click this button to update your software. Use this option to check for both, major and minor versions of the software.

Click this button to purchase the software.

Click this button to visit the Knowledge Base articles of stellarinfo.com

Click this button to open the help manual for **Stellar Repair for MS SQL**.
Click this button to read more information about the software.
Ordering the Software

Click https://www.stellarinfo.com/sql-database-toolkit.php to know more about Stellar Toolkit for MS SQL.

To purchase the software online, please visit https://www.stellarinfo.com/database-recovery/sql-toolkit/buy-now.php

Alternatively, click on Buy Online icon in Buy Now ribbon to purchase the software online.

Select either of the methods given above to purchase the software.

Once the order is confirmed, a key will be sent to you through e-mail, which would be required to activate the software.
Activating the Software

The demo version is for evaluation purpose only. You need to activate the software to use its full functionality. Use the Activation Key received via email after purchasing the software to activate it.

To activate the software:

1. Run the software.
2. Click the Activation button. Activation window is displayed as shown below:

   ![Activation Window]

3. If you don't have the activation key, click Get it now button in the window to purchase the software.
4. Once the order is confirmed, an Activation Key is sent to the email that you have provided while purchasing the software.
5. Paste or type the Activation Key (received through email after purchasing the product) and click Activate button (Please ensure an active Internet connection).
6. The software automatically communicates with the license server to verify the entered key. If the entered key is valid, activation is completed successfully.
7. 'Activation Completed Successfully' message is displayed. Click OK.
Updating the Software

There are periodical software updates for Stellar Repair for MS SQL. Using the update option, you can check for both the latest minor and major version available online. You can easily download the minor and major version through the update wizard. While updating the software, it's recommended to close all the running programs.

To start Stellar Repair for MS SQL Update Wizard:

1. Run Stellar Repair for MS SQL software.
2. Select Update from Tools Menu.
3. Update window pops up.
4. The wizard will start searching for the latest updates and if it finds any new version, a window will pop up indicating the availability an update.
5. Click Next and the software will start downloading update files from the server. When the process is complete, the software will updated to the latest version.

Live Update may not happen due to following reasons:

- Internet connection failure
- Unable to download configuration files
- Unable to locate updated files or version
- Unable to locate executable file
Stellar Support

Our Technical Support professionals will give solutions for all your queries related to Stellar products.

You can either call us or go online to our support section at http://www.stellarinfo.com/support/

For price details and to place the order, click https://www.stellarinfo.com/database-recovery/sql-toolkit/buy-now.php

Chat Live with an Online technician at http://www.stellarinfo.com/

Search in our extensive Knowledge Base at http://www.stellarinfo.com/support/kb

Submit enquiry at http://www.stellarinfo.com/support/enquiry.php

Send e-mail to Stellar Support at support@stellarinfo.com
How To...

- Select MS SQL database (MDF) File
- Include Deleted Records
- Repair MDF files
- Save Scan Information
- Preview and Save MDF Files
- Find Specific Item In Tree
- Save Log Report
Select MS SQL Database (MDF) File

To select MDF file:

Stellar Repair for MS SQL allows you to select MS SQL database (MDF) files from your computer for the repairing process.

1. Open Select Database dialog box by choosing Select Database icon from File Menu.
2. In Select Database dialog box, click Browse.
3. Open dialog box will appear. Browse and select the desired file and then click Open.
4. Select ‘Include Deleted Records’ check box to recover deleted records (if found) during the repairing process.

To find MDF File:

Stellar Repair for MS SQL also allows you to search for MS SQL database (MDF) files in your computer. Using Search option, you can search for MS SQL Database files in your computer’s drives, folders and sub folders. However, you can only select one drive at a time to search for MS SQL Database files.

To find MDF files in drives:

1. Open Select Database dialog box by choosing Select Database icon from File Ribbon
2. From Search section, select the drive you want to search for MDF files. Click OK.
3. After the search is finished, a list of MS SQL Database files found in the selected drive is shown.
4. Select file you wish to repair from this list and click Repair button to start the repairing process.

To find MS SQL Database files in folders and subfolders:
1. Open **Select Database** dialog box by choosing **Select Database** icon from **File Ribbon**

2. From **Search** section, select the folder or subfolder you want to search for MDF files. Click **OK**.

3. After the search is finished, a list of MS SQL Database files found in the selected drive is shown.

4. Select file you wish to repair from this list and click **Repair** button to start the repairing process.

**Note:** *Click Clear List button to clear the search result.*
Include Deleted Records

**Stellar Repair for MS SQL** provides you an option to include deleted records in MS SQL database (MDF) repaired file.

To include deleted records follow the steps given below:

1. Select the file by clicking on the **Select Database** icon from the **File Ribbon** or from the list of MS SQL Database files found, select the desired file to repair.

2. Select '**Include Deleted Records**' check box to recover deleted records (if found) during the repairing process.

3. Click **Repair** to start the repairing process. Repairing of the selected files is performed by the tool.
Repair MDF Files

Stellar Repair for MS SQL repairs MS SQL Database (MDF) files and allows you to save to your preferred location. You can also preview the repaired database before saving it.

To repair MS SQL Database files:

1. Select the file by clicking on the Select Database icon from the File ribbon or from the list of MS SQL Database files found, select the desired file to repair.

2. Click Repair to start the repairing process. Repairing of the selected files is performed by the tool.

3. After the completion of repairing process, a message appears indicating the successful completion of the process.

Note:

- If the selected database file is heavily corrupted and application is unable to detect the database file version, then you can select the database version manually from the dialog box as shown below:
If in case you select invalid version of the database file, then a message prompts on the screen indicating the inappropriate version of file.

To proceed to the repairing process, you need to select the appropriate version.
Save Scan Information

**Stellar Repair for MS SQL** saves a scan information of the MS SQL Database (MDF) File at the time of repairing. This saved scan information can be used later to repair corrupt database in case you wish to repair the database file again.

Using a scan information saves time, since scanning of each database file does not take place. All files and folders shown after scan process can be viewed as we load the saved scan information created for that particular scan. You can resume recovery by selecting the saved scan information without scanning the database again.

**To Repair Database using scan information**

1. You will be prompted to use the saved scan information for selected database.
2. Click Yes if you want to repair using the existing saved scan information.
3. Click No if you want to repair using selected database itself.
Preview and Save MDF Files

After you complete the repairing process successfully, Stellar Repair for MS SQL shows preview of corrupted database files. The left pane displays list of items (Tables, Views, Synonyms, Defaults, Data Types and more) in a tree like structure, upper right pane displays the contents of the item selected in the tree view and bottom pane shows message log. A sample screen is displayed below:

By default, all the checkboxes of the tree view are selected. You can click on the item in the tree view to preview its content.

**Note:** The software performs a counting of records present in the database after repairing process is completed. The time taken in counting depends on the number of records present in the database. You can skip the counting of records to speed up repair process without affecting the repair results.

**To save the repaired file to MS SQL database:**

- After the repairing process gets completed, click **Save** option from **File ribbon**.

- Specify whether you want to save the repaired database in **MDF, CSV, HTML** or **XLS** format by selecting the appropriate radio button.

**Saving repaired database as MDF**

**Saving repaired database as CSV, HTML or XLS**

If you want to save your repaired database as an MDF, you can either save your database as a **New database** or you can insert the data to an existing **Live database**.

- To save the repaired database as a completely **New database**, follow the steps mentioned below:
  - Select **New Database** radio button.
  - Enter **Server / Instance Name**.
Choose the **Authentication** method from the drop down list for logging in to the server. If the authentication method selected is **Windows Authentication**, you need not enter any user name and password.

Enter the server user name and password, if the selected authentication method is **SQL Server Authentication**.

Select a destination for saving the repaired MDF file.

Click **Save** button to save the repaired MS SQL Database file. A message is displayed after the process is completed successfully.
To save the repaired database in an existing Live database, follow the steps mentioned below:

- Select Live Database radio button.
- Enter Server / Instance Name.
- Choose the Authentication method from the drop down list for logging in to the server. If the authentication method selected is Windows Authentication, you need not enter any user name and password.
- Enter the server user name and password, if the selected authentication method is SQL Server Authentication.
o From the **Existing Database** drop down button select the database into which you want to save the repaired file.

o Click **Save** button to save the repaired MS SQL Database file. A message is displayed after the process is completed successfully.

**To save the repaired file to CSV, HTML or XLS format:**

- After the repairing process gets completed, go to **File ribbon** and select **Save** option.
- **Save** dialog box will open. Select the required format.
• Click **Browse** to go to the folder where you want to save the repaired file and click **Save** button.

• The file will be saved in the desired format.

**Note:** *Perform repair process on the copy of database and make sure MS SQL Server is running during repair process.*
Find Specific Item In Tree

**Stellar Repair for MS SQL** gives option to find particular item(s) in tree view. After completion of repairing process, a search bar along with the preview window appears as shown below:

![Find Tree Item](image)

To find a particular item, enter its name in **Find Tree Item** text box and click **Find** button. If that item is present in the database, it is highlighted in tree. Use back `<` and forward `>` button to traverse in the tree.

To narrow down the search result, you can select **Match case** or **Match whole word** check box.
Save Log Report

With Stellar Repair for MS SQL, you can save the Log Report to analyze the repairing process at a later stage. You can view log of the process at the bottom of the user interface. If this pane is not visible, you can enable it by selecting the Log Window checkbox in View section of File Ribbon.

To save log report:

- From Tools Ribbon, select Save Log.
- In Save As dialog box, select the location where you want to save the log report. Click Save.

To clear log report:

- From Tools Ribbon, select Clear Log.
FAQs

1. What does the demo version of the software do?

   Demo version of the software only shows the preview of MDF files. To repair corrupt MDF file, you need to purchase and register the software.

2. Why is it necessary to perform repair process on the copy of database?

   Stellar Repair for MS SQL will not be able to run if the database is attached to MS SQL Server.

3. Can we repair table(s) in a MDF file selectively?

   Yes, you can recover single or multiple tables. Simply select desired table(s) in tree view and start repair process.

4. How can Stellar Repair for MS SQL help me search for the location of MDF file in the computer?

   You can search for MDF file in the computer using Search option of the software. For more details, please refer Select MS SQL database ( MDF ) File topic of the help manual.

5. I want to locate an item in the database ( MDF ) file. Is there any way I can do this using the software?

   Yes, after repairing the MDF file, the software gives you option to find items in tree view. Use Find option to locate desired item in a table.

6. How can we view process log?

   You can view log of the process at the bottom of the user interface. If this pane is not visible, you can enable it by selecting the Log Window checkbox in View section of File Menu.

7. Can we save process log?

   Yes, Stellar Repair for MS SQL gives you option to save log report of the process.

   To save log report:

   - From Tools Menu, select Save Log.
   - In Save As dialog box, select the location where you want to save the log report. Click Save.
Stellar Password Recovery for MS SQL 9.0

User Manual
Overview

Microsoft SQL Server is a database management system developed by Microsoft, whose primary function is to store and retrieve data. You can set passwords for Microsoft SQL server files, in order to prevent unauthorized access to such files. However, it may happen that you forget the password and are unable to access the file or, you want to access a password protected file owned by someone else. Stellar Password Recovery for MS SQL software helps you to reset the password of a protected file.

Key Features

- Support MSSQL 2017, 2016, 2014
- One-Click process to change the password of a protected file.
- Simple and easy to use user interface.
Installation Procedure

Before installing the software, check that your system meets the minimum system requirements:

**Minimum System Requirements:**

- **Processor:** Intel Pentium Class
- **Operating system:** Windows Server 2012 / 2008 / 2003 and Windows 10 / 8.1 / 8 / 7
- **Hard Disk:** At least 250 MB of free disk space
- **RAM:** 2 GB minimum (4 GB recommended)

To install the software, follow the steps:

1. Double-click **StellarToolkitforMSSQL.exe**. Setup dialog box is displayed.
2. Click **Next** to continue. **License Agreement** dialog box is displayed.
3. Select **I accept the Agreement** option. Click **Next**.
4. Specify the location where the installation files are to be stored. Click **Next**.
5. Select the folder where the files are to be stored. A default folder is suggested in the box. Click **Browse** to select a different location. Click **Next**.
6. In the **Select Additional Tasks** dialog box, select check boxes as per your choice. Click **Next**.
7. Review your selections. Click **Back** if you want to make any change. Click **Install** to start installation. The Installing window shows the installation process.
8. After completion of the process, **Completing the Stellar Toolkit for MS SQL Setup Wizard** window opens. Click **Finish**.

**Note:** Clear **Launch Stellar Toolkit for MS SQL** check box to prevent the software from launching automatically.
Launching the Software

To launch Stellar Password Recovery for MS SQL in Windows 10:

- Click Start icon -> All apps -> Stellar Toolkit for MS SQL -> Stellar Toolkit for MS SQL -> Recover MS SQL Password. Or,
- Double click Stellar Toolkit for MS SQL icon on the desktop -> Recover MS SQL Password. Or,
- Click Stellar Toolkit for MS SQL tile on the home screen -> Recover MS SQL Password.

To launch Stellar Password Recovery for MS SQL in Windows 8.1 / 8:

- Click Stellar Toolkit for MS SQL tile on the home screen -> Recover MS SQL Password. Or,
- Double click Stellar Toolkit for MS SQL icon on the desktop -> Recover MS SQL Password.

To start the application, do one of the following in Windows 7:

- Click Start -> All Programs -> Stellar Toolkit for MS SQL -> Stellar Toolkit for MS SQL -> Recover MS SQL Password. Or,
- Double click the Stellar Toolkit for MS SQL icon on the desktop -> Recover MS SQL Password. Or,
- Click Stellar Toolkit for MS SQL icon in Quick launch -> Recover MS SQL Password.
Ordering the Software

Click https://www.stellarinfo.com/sql-database-toolkit.php to know more about Stellar Toolkit for MS SQL.

To purchase the software online, please visit https://www.stellarinfo.com/database-recovery/sql-toolkit/buy-now.php

Alternatively, click on Purchase icon in Help Menu on Menu Bar to purchase the software online.

Select either of the methods given above to purchase the software.

Once the order is confirmed, a serial number will be sent to you through e-mail, which would be required to activate the software.
Activating the Software

The demo version is just for evaluation purposes and must be eventually registered to use the full functionality of the software. The software can be registered using the Activation Key that you receive via email after purchasing the software.

To activate the software:

1. Run the demo version of the software.

2. Go to the Activation menu, click the Activation option. The Activation window is displayed as shown below:

   ![Activation Window](image)

3. If you don't have the activation key, click the Get it now button in the window to go online and purchase the product.

4. Once the order is confirmed, an Activation Key will be sent to the email provided.

5. Type the Activation Key (received through email after purchasing the product) and click Activate button (Please ensure that you have an active Internet connection).

6. The software will automatically communicate with the license server to verify the entered key. If the key you entered is valid, the software will be registered successfully.

7. The 'Activation Complete' message is displayed after the process is completed successfully. Click OK.
Updating the Software

Stellar releases periodical software updates for Stellar Password Recovery for MS SQL software. You can update the software to keep it up-to-date. These updates can add a new functionality, feature, service, or any other information that can improve the software. Update option of the application is capable of checking for latest updates. This will check for both latest minor and major versions available online. You can easily download minor version through the update wizard. However, the major version, if available, has to be purchased. While updating the software, it’s recommended to close all the running programs. Note that demo version of the software cannot be updated.

To update Stellar Password Recovery for MS SQL:

- Click Updates button on the application tool bar. Update Wizard is displayed.
- Click Next. The wizard will search for latest updates, and if it finds any new updates, a window will pop up indicating its availability.
- Click Next and the software will download the files from the update server. When the process is complete, the software will upgrade to the latest version.

Live Update may not happen due to following reasons:

- Internet connection failure
- Updates are not available
- Unable to download configuration files
- Unable to locate updated files or version
- Unable to locate executable file
Stellar Support

Our Technical Support professionals will give solutions for all your queries related to Stellar products.

You can either call us or go online to our support section at [http://stellarinfo.com/support/](http://stellarinfo.com/support/)

For price details and to place the order, click [https://www.stellarinfo.com/database-recovery/sql-toolkit/buy-now.php](https://www.stellarinfo.com/database-recovery/sql-toolkit/buy-now.php)


Search in our extensive Knowledge Base at [http://www.stellarinfo.com/support/kb/](http://www.stellarinfo.com/support/kb/)


E-mail to Stellar Support at support@stellarinfo.com
Buttons

Click this button to read more information about Stellar Password Recovery for MS SQL.

Click this button to purchase Stellar Toolkit for MS SQL.

Click this button to register Stellar Toolkit for MS SQL after purchasing.

Click this button to update Stellar Password Recovery for MS SQL. Use this option to check for both, major and minor versions of the software.

Click this button to open the help manual for Stellar Password Recovery for MS SQL.

Click this button to select the file whose password needs to be recovered.

Click this button to set a new password for the selected file.

Click this button to quit Stellar Password Recovery for MS SQL.
How To...

- Select Database
- Change Password
Select Database

- Launch Stellar Password Recovery for MS SQL. Click Browse.

- In Open dialog box, locate the MSSQL (master.mdf) file of the database from which you want to recover the password. Click Open.

- List of accounts in the selected database appear in the application window.
Change Password

- In the application window, select the account from the **User Name** column whose password needs to be recovered.
- Click **Change Password**. **Change Password** dialog box opens.

- Enter the new password for the account. Click **OK**.
A confirmation message appears indicating that the password has been successfully changed.
FAQs

1. **Can I change my password using demo version of the software?**
   
   No, you cannot change the password using demo version of the software. You need to purchase the software in order to change the password.

2. **Which versions of Microsoft SQL server are supported by the software?**
   
Legal Notices

Copyright

Stellar Toolkit for MS SQL software, accompanied user manual and documentation are copyright of Stellar Information Technology Private Limited, with all rights reserved. Under the copyright laws, this user manual cannot be reproduced in any form without the prior written permission of Stellar Information Technology Private Limited. No Patent Liability is assumed, however, with respect to the use of the information contained herein.

Copyright © Stellar Information Technology Private Limited. All rights reserved.

Disclaimer

The Information contained in this manual, including but not limited to any product specifications, is subject to change without notice.

STELLAR INFORMATION TECHNOLOGY PRIVATE LIMITED PROVIDES NO WARRANTY WITH REGARD TO THIS MANUAL OR ANY OTHER INFORMATION CONTAINED HEREIN AND HEREBY EXPRESSLY DISCLAIMS ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR ANY PARTICULAR PURPOSE WITH REGARD TO ANY OF THE FOREGOING STELLAR INFORMATION TECHNOLOGY PRIVATE LIMITED ASSUMES NO LIABILITY FOR ANY DAMAGES INCURRED DIRECTLY OR INDIRECTLY FROM ANY TECHNICAL OR TYPOGRAPHICAL ERRORS OR OMISSIONS CONTAINED HEREIN OR FOR DISCREPANCIES BETWEEN THE PRODUCT AND THE MANUAL. IN NO EVENT SHALL STELLAR INFORMATION TECHNOLOGY PRIVATE LIMITED, BE LIABLE FOR ANY INCIDENTAL, CONSEQUENTIAL SPECIAL, OR EXEMPLARY DAMAGES, WHETHER BASED ON TORT, CONTRACT OR OTHERWISE, ARISING OUT OF OR IN CONNECTION WITH THIS MANUAL OR ANY OTHER INFORMATION CONTAINED HEREIN OR THE USE THEREOF.

Trademarks

Stellar Toolkit for MS SQL® is a registered trademark of Stellar Information Technology Private Limited.


All Trademarks Acknowledged.

All other brands and product names are trademarks or registered trademarks of their respective companies.
END USER LICENSE AGREEMENT

PLEASE READ THIS AGREEMENT CAREFULLY. BY DOWNLOADING, INSTALLING, COPYING, ACCESSING OR USING THIS SOFTWARE, ALL OR ANY PORTION OF THIS SOFTWARE, YOU (HEREINAFTER “CUSTOMER”) ACCEPT ALL THE TERMS AND CONDITIONS OF THIS AGREEMENT WHICH WILL BIND YOU. THE TERMS OF THIS LICENSE INCLUDE, IN PARTICULAR, LIMITATIONS ON LIABILITY CLAUSE.

IF YOU DO NOT AGREE TO THE TERMS OF THIS LICENSE, WE WILL NOT LICENSE THE SOFTWARE AND DOCUMENTATION TO YOU AND YOU MUST DISCONTINUE THE INSTALLATION PROCESS NOW, AND PROMPTLY RETURN THE SOFTWARE AND PROOF OF ENTITLEMENT TO THE PARTY FROM WHOM YOU ACQUIRED THE SOFTWARE.

1. DEFINITIONS.

1.1 “Stellar” means Stellar Information Technology Pvt. Ltd., having its registered office at 205, Skipper Corner, 88, Nehru Place, New Delhi, India 110019.

1.2 “Compatible Computer” means a Computer with the recommended operating system and hardware configuration as stated in the Documentation.

1.3 “Computer” means a virtual or physical device that accepts information in digital or similar form and manipulates it for a specific result based on a sequence of instructions, including without limitation desktop computers, laptops, tablets, mobile devices, telecommunication devices, Internet-connected devices, and hardware products capable of operating a wide variety of productivity, entertainment, or other software applications.

1.4 “Customer” means you and any legal entity that obtained the Software and on whose behalf it is used; for example, and as applicable, your employer.

1.5 “Permitted Number” means one (1) unless otherwise indicated under a valid license (e.g., volume license) granted by Stellar.

1.6 “Software” means (a) all of the information with which this agreement is provided, including but not limited to: (i) all software files and other computer information; (ii) any proprietary scripting logic embedded within exported file formats (iii) images, sounds, clip art, video and other works bundled with Stellar software or made available by Stellar on Stellar’s website for use with the Stellar software and not obtained from Stellar through a separate service (unless otherwise noted within that service) or from another party (“Content Files”); (iv) related explanatory written materials and files (“Documentation”); and (v) any modified versions and copies of, and upgrades, updates, and additions to, such
information, provided to Customer by Stellar at any time, to the extent not provided under separate terms (collectively, “Updates”).

2. LICENSE GRANT; PROPRIETARY RIGHTS

Right to use the Software: Subject to the terms and conditions of this Agreement, Stellar grants Customer a non-exclusive, non-transferable right, revocable and limited license to access and use the Software and Documentation on a single computer or workstation in a single location for your personal purposes (if you are a consumer) or your internal business purposes (if you are a business user) subject to the terms stated below. Customer must use the Technician License if using the software to provide professional or paid service to a third party (individual or company) and / or for any commercial purposes.

SINGLE USER LICENSE. The term means a SOFTWARE that may be installed and used only by a single USER on a single computer at any one time. Consequently, the SOFTWARE must not be installed, displayed, shared or used concurrently from the computer or on distinct computers. Single User License is granted to customer who is using STANDARD, PROFESSIONAL, PREMIUM or CORPORATE Edition of the Software.

MULTIPLE USER LICENSE. The term means a SOFTWARE that may be installed and used by a specified number of USERS representing an equivalent number of computers. The SOFTWARE must not be installed, displayed, shared or used from or on a number of computers greater than the number of workstations authorized. Multiple User License are associated with Technician & Toolkit Edition of the Software. MAXIMUM Installation and usage limit of this License in on 3 Computers.

3. LICENSE TYPES

3.1 Evaluation Software/Trial version: The Software is provided with or without License key which can be downloaded for free from Stellar’s website. The Software may only be installed and used on Permitted Number of Compatible Computers during the License Term for demonstration, evaluation, and training purposes only. Evaluation Software or Trial version of the Software may be freely distributed, if the distribution package is not modified. No person or company may charge a fee for the distribution of trial version without written permission from the copyright holder.

3.2 Subscription License: For the Software available on a subscription-basis (“Subscription License”), Customer may install and use the Subscription License only on the Permitted Number of Compatible Computer during the License Term Period. Subject to the Permitted Number of Computers for the Subscription License, Customer agrees that Stellar may change the type of Software (such as specific components, versions, platforms, languages, etc.) included in the
Subscription License at any time and shall not be liable to the Customer whatsoever for such change. Ongoing access to a Subscription License requires a recurring Internet connection to activate, renew, and validate the license. If Stellar does not receive the recurring subscription payment or cannot validate the license periodically, then the Software may become inactive without additional notice until Stellar receives the payment or validates the license.

3.3 **Lifetime License:** Once registered, user is granted an exclusive license to use the Software for maximum period of 10 years on the same computer with same configuration and operating system which is compatible with the software. If the computer hardware or software is changed during the lifetime of the license which is not compatible with the original purchased version; then user may need to additionally purchase the upgraded version of the software.

4. **SOFTWARE SUPPORT.**

Support will only be provided to only license customer for a period of 1 Year from the date of purchase. Queries regarding the installation and use of the software should be submitted by e-mail which get responded usually within 24 Business Hours.

Free Technical Support is provided for 1 Year from the date of purchase, if your license term is greater than 1 year then you may avail Technical Support by paying additional fee applicable at that time. Paid support can be purchased for Lifetime License only upto a maximum period of next 2 years. Stellar will not assist customers for any support request related to the Software after 3 years from the purchase of the software.

5. **INTELLECTUAL PROPERTY OWNERSHIP.**

The Software and any authorized copies that Customer makes are the intellectual property of and are owned by Stellar. The structure, organization, and source code of the Software are the valuable trade secrets and confidential information of Stellar Information Technology Pvt. Ltd. The Software is protected by law, including but not limited to the copyright laws of the United States and other countries, and by international treaty provisions. Except as expressly stated herein, this agreement does not grant Customer any intellectual property rights in the Software. All rights not expressly granted are reserved by Stellar.

6. **RESTRICTIONS & REQUIREMENTS.**

6.1 **Proprietary Notices.** Any permitted copy of the Software (including without limitation Documentation) that Customer makes must contain the same copyright and other proprietary notices that appear on or in the Software.
6.2 Use Obligations. Customer agrees that it will not use the Software other than as permitted by this agreement and that it will not use the Software in a manner inconsistent with its design or Documentation.

6.3 No Modifications. Customer shall not modify, adapt, tamper with, translate or create Derivative Works of the Software or the Documentation; combine or merge any part of the Software or Documentation with or into any other software or documentation; or refer to or otherwise use the Software as part of any effort to develop software (including any routine, script, code, or program) having any functional attributes, visual expressions or other features similar to those of the Software to compete with Stellar; except with Stellar’s prior written permission, publish any performance or benchmark tests or analysis relating to the Software;

6.4 No Reverse Engineering. Customer shall not reverse engineer, decompile, disassemble, or otherwise attempt to discover the source code of the Software.

6.5 No Unbundling. The Software may include various applications and components, may allow access to different Stellar Online Channels, may support multiple platforms and languages, and may be provided to Customer on multiple media or in multiple copies. Nonetheless, the Software is designed and provided to Customer as a single product to be used as a single product on Computers as permitted herein. Unless otherwise permitted in the Documentation, Customer is not required to install all component parts of the Software, but Customer shall not unbundle the component parts of the Software for use on different Computers.

6.6 Customer will not remove, erase, obscure or tamper with any copyright or any other product identification or proprietary rights notices, seal or instructional label printed or stamped on, affixed to, or encoded or recorded in or on any Software or Documentation; or fail to preserve all copyright and other proprietary notices in all copies Company makes of the Software and Documentation;

6.7 Customer will not run or operate the Software in a cloud, Internet-based computing or similar on-demand computing environment unless Company’s Grant Letter or the applicable Product Entitlement Definitions specifically allows the use.

6.8 No Transfer. Customer will not rent, lease, sell, sublicense, assign, or transfer its rights in the software (including without limitation, software obtained through a web download), or authorize any portion of the software to be copied onto another individual or legal entity’s computer except as may be expressly permitted herein.

7. COPYRIGHT/OWNERSHIP.
Customer acknowledges that all intellectual property rights in the Software and the Documentation anywhere in the world belong to, or are licensed to Stellar. The rights granted to you in the Software are licensed (not sold), and you have no rights in, or to, the Software or the Documentation other than the right to use them in accordance with the terms of this License. The Software, its source code and Documentation are proprietary products of Stellar Information Technology Pvt. Ltd. (“Stellar”) to provide the License and are protected by copyright and other intellectual property laws. Stellar shall at all times retain all rights, title, interest, including intellectual property rights, in the Software or Documentation.

8. WARRANTIES.

The licensed software (excluding the media on which it is distributed) and all Stellar related websites and services are provided to licensee ‘AS IS’ and “AS AVAILABLE,” and Stellar and its suppliers and licensors make NO WARRANTY as to their use or performance. Stellar and its suppliers and licensors make NO WARRANTIES OR REPRESENTATIONS (express or implied, whether by statute, common law, custom, usage, or otherwise) as to any matter including without limitation to quality, availability, performance or functionality of the licensed software or any related Stellar websites or services; quality or accuracy of any information obtained from or available through use of the licensed software or related Stellar websites or services; any representation or warranty that the use of the licensed software or any related Stellar websites or services will be uninterrupted or always available (whether due to internet failure or otherwise), error-free, free of viruses or other harmful components or operate on or with any particular hardware, platform or software; non-infringement of third-party rights, merchantability, integration, satisfactory quality, or fitness for any particular purpose, except for, and only to the extent, that a warranty may not be excluded or limited by applicable law in licensee’s jurisdiction.

9. DATA PROTECTION.

You understand that by using the Licensed Software, you consent and agree to the collection and use of certain information about you and your use of the Licensed Software in accordance with Stellar’s Privacy Policy. You further consent and agree that Stellar may collect, use, transmit, process and maintain information related to your Account, and any devices or computers registered thereunder, for purposes of providing the Licensed Software, and any features therein, to you. Information collected by Stellar when you use the Licensed Software may also include technical or diagnostic information related to your use that may be used by Stellar to support, improve and enhance Stellar’s products and services. For more information please read our full privacy policy at “https://www.stellarinfo.com”, on the section Privacy Policy. You further understand and agree that this information may be transferred to the United States, India and/or other countries for storage, processing and use by Stellar, its affiliates, and/or their service providers. You hereby
agree and consent to Stellar’s and its partners’ and licensors’ collection, use, transmission, processing and maintenance of such location and account data to provide and improve such features or services.

10. INTERNET CONNECTIVITY & PRIVACY.

10.1 Automatic Connections to the Internet. The Software may cause Customer’s Computer, without notice, to automatically connect to the Internet and to communicate with Stellar website or Stellar domain for purposes such as license validation and providing Customer with additional information, features, or functionality. Unless otherwise specified in Sections 10.2 through 10.5, the following provisions apply to all automatic Internet connections by the Software:

10.1.1 Whenever the Software makes an Internet connection and communicates with a Stellar website, whether automatically or due to explicit user request, the Privacy Policy shall apply. Stellar Privacy Policy allows tracking of website visits and it addresses in detail the topic of tracking and use of cookies, web beacons, and similar devices.

10.1.2 Whenever the Software connects to Stellar over the Internet, certain Customer information is collected and transmitted by the Software to Stellar pursuant to the Stellar Online Privacy Policy available at https://www.stellarinfo.com/ under Privacy Policy section.

10.1.3 If Customer accesses Stellar Online Service or activates or registers the Software, then additional information such as Customer’s ID, user name, and password may be transmitted to and stored by Stellar pursuant to the Privacy Policy and additional terms of use related to such Stellar Online Service.

10.1.4 Stellar, unless barred under applicable law, may (a) send Customer transactional messages to facilitate the Stellar Online Service or the activation or registration of the Software or Stellar Online Service, or (b) deliver in-product marketing to provide information about the Software and other Stellar products and Services using information including but not limited to platform version, version of the Software, license status, and language.

10.2 Updating. The Software may cause Customer’s Computer, without additional notice, to automatically connect to the Internet (intermittently or on a regular basis) to (a) check for Updates that are available for download to and installation on the Computer and (b) notify Stellar of the results of installation attempts.

10.3 Activation. The Software may require Customer to (a) obtain Stellar Software Activation Key, (b) activate or reactivate the Software, (c) register the software, or (d) validate the Ownership. Such requirement may cause Customer’s Computer to connect to the Internet without notice on install, on launch, and on a regular basis thereafter. Once connected, the Software will collect and transmit information to Stellar. Software or Customer may also receive information from Stellar related to Customer’s license, subscription, or Ownership. Stellar may use such information to
detect or prevent fraudulent or unauthorized use not in accordance with a valid license, subscription, or Ownership. Failure to activate or register the Software, validate the subscription or Ownership, or a determination by Stellar of fraudulent or unauthorized use of the Software may result in reduced functionality, inoperability of the Software, or a termination or suspension of the subscription or Ownership.

10.4 Use of Online Services. The Software may cause Customer’s Computer, without additional notice and on an intermittent or regular basis, to automatically connect to the Internet to facilitate Customer’s access to content and services that are provided by Stellar or third parties. In addition, the Software may, without additional notice, automatically connect to the Internet to update downloadable materials from these online services so as to provide immediate availability of these services even when Customer is offline.

10.5 Digital Certificates. The Software uses digital certificates to help Customer identify downloaded files (e.g., applications and/or content) and the publishers of those files. For example, Stellar uses digital certificates to help Customer identify the publisher of Stellar applications. Customer’s Computer may connect to the Internet at the time of validation of a digital certificate.

11. LIMITATION OF LIABILITY

In no event shall Stellar or its suppliers be liable for any special, incidental, indirect, or consequential damages whatsoever (including, without limitation, damages for loss of business profits, business interruption, loss of business information, or any other pecuniary loss) arising out of the use of or inability to use the software product or the provision of or failure to provide support services, even if Stellar has been advised of the possibility of such damages. In any case, Stellar’s entire liability under any provision shall be limited to the amount actually paid by you for the software product or a sum of US Dollars Five whichever is higher.

12. TERMINATION

If Customer breaches this EULA, and fails to cure any breach within 30 calendar days after request from Stellar, Stellar may terminate this EULA, whereupon all rights granted to Customer shall immediately cease including but not limited to the license granted to the customer to use the software which shall also stand revoked. Furthermore, upon termination, Customer shall return to Stellar all copies of the Licensed Software, or verify in writing that all copies of the Licensed Software have been destroyed and failure of the customer to do so would entitle Stellar to sue for relief in equity and damages.

13. JURISDICTION AND LAW
13.1 This EULA is subject to, and will be governed by and construed in accordance with the substantive laws applicable to the state of Delhi (India). Courts at Delhi, India alone shall have the jurisdiction to entertain any dispute arising out of the terms and conditions of this EULA and you consent to such jurisdiction of the courts at Delhi, India.

13.2 This EULA will not be governed by the conflict of law rules of any jurisdiction, or the United Nations Convention on Contracts for the International Sale of Goods, the application of which is expressly excluded.

14. GENERAL

14.1 This License is the complete statement of the agreement between the parties on the subject matter and merges and supersedes all other or prior understandings, purchase orders, agreements and arrangements.

14.2 The exclusions of warranties and liability limitations shall survive the termination of this EULA, howsoever caused; but this survival shall not imply or create any continued right to use the Licensed Software after termination of this EULA.

14.3 Licensee shall not ship, transfer, or export Licensed Software into any country or use Licensed Software in any manner prohibited by the applicable export control laws, notably where applicable, the United States Export Administration Act, restrictions, or regulations (collectively the ‘Export Laws’.) All rights to use the Licensed Software are granted on condition that Licensee complies with the Export Laws, and all such rights are forfeited if Licensee fails to comply with the Export Laws.

14.4 Stellar reserves all rights not expressly granted to Licensee by this EULA All rights are reserved under the copyright laws of India and/or of other countries, to Stellar Information Technology Pvt Ltd, having its registered office at 205, Skipper Corner, 88, Nehru Place, New Delhi, India 110019.

14.5 There are no third party beneficiaries of any promises, obligations or representations made by Stellar herein.

14.6 Any waiver by Stellar of any violation of this License by you shall not constitute nor contribute to a waiver by Stellar of any other or future violation of the same provision or any other provision of this License.

14.7 This EULA constitutes the entire agreement between you and Stellar and it supersedes all prior or contemporaneous representations, discussions, undertakings, communications, agreements, arrangements, advertisements, and understandings regulating the Licensed Software. This EULA is binding on and made for the benefit of the parties and their successors and permitted assigns.

14.8 This EULA may only be modified, supplemented or amended by a writing signed by an authorized officer of Stellar.

Copyright © Stellar Information Technology Private Limited. All rights reserved.
About Stellar

Stellar is the world’s foremost Data Care Corporation, with expertise in Data Recovery, Data Erasure, Mailbox Conversion, and File Repair software and services. Stellar has been in existence from past 25+ years and is a customer-centric, critically acclaimed, global data recovery, data migration & erasure solutions provider with cost-effective solutions available for large corporate, SMEs & Home Users.

Stellar has a strong presence across USA, Europe & Asia.

Product Line:

Stellar provides a wide range of Do It Yourself (DIY) Software for Consumer as well as Software for Businesses:

**Data Recovery**

The widest range of data recovery software that helps you recover your valued data lost after accidental format, virus problems, software malfunction, file/directory deletion, or even sabotage!

**File Repair**

The most comprehensive range of file repair software for Windows, Mac and Linux. Recover your files, which have been infected by viruses, malwares or have been damaged by improper shutdown and other corruption-related issues.

**Data Erasure**

Best software for IT assets disposition. Secure and erase variety of storage media and files from PC/Laptop, Servers, Rack Drives or Mobile devices. Data once erased cannot be recovered by using any data recovery software or service.

**Email Repair & Converter**

Robust applications to restore inaccessible mailboxes of MS Exchange, Outlook, AppleMail, Thunderbird, Eudora, Spicebird, Entourage, and Pocomail mailbox. Also, tools to convert mailboxes and database files from one format to another.

**Database Repair**

Professional and reliable software to repair corrupt or damaged database for Microsoft SQL Server, QuickBooks®, Microsoft Access, SQLite and many more.

**Email Backup Tools**

Fully featured backup utilities that provides a comprehensive solution in case of any disaster. These software facilitates taking back up of all your mails, contacts, tasks, notes, calendar entries, journals etc. with full & incremental backup options.
Photo and Video Tools

Professional tools to rebuild damaged or corrupt photos, videos, audios, and other multimedia files, from Window and Mac systems. Recover files from hard drives, memory cards, iPods, USB flash drives, digital cameras, IBM Micro Drives and more.

Utility Tools

A range of utility software such as SpeedUp Mac, Drive Clone and Partition Manager for Mac systems as well as Password Recovery for Windows and Password Recovery for Windows Server based systems.

Stellar Toolkits

Stellar also provides toolkits that are combination of Powerful Tools Designed for Data Recovery, File repair, Mailbox repair and File Conversion. All in one power packed toolkits to meet the need of every business.

For more information about us, please visit www.stellarinfo.com